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1. Перечень компетенций и индикаторов их достижения 

 

Процесс изучения дисциплины направлен на формирование следующих компетенций: 

Код и наименование 
компетенции 

Код и наименование 

индикатора достижения 
компетенций 

Этап 

Предшествующие этапы 

(с указанием 
дисциплин/практик) 

ПК-4 Способен к 
устранению 
технических проблем на 
станционном 
оборудовании связи 

 

ПК-4.2 Знает 
теоретические основы 
работы,  конструкцию, 
параметры 
компонентов и 
устройств 
телекоммуникационных 
систем 

2 

 

- 

 

Форма промежуточной аттестации по дисциплине – зачет 

 

 

 

2. Показатели, критерии и шкалы оценивания компетенций 

 

2.1 Показателем оценивания компетенций на этапе их формирования при изучении 
дисциплины является уровень их освоения. 

 

Индикатор освоения 
компетенции 

Показатель оценивания Критерий оценивания 

ПК-4.2 Знает 
теоретические основы 
работы,  конструкцию, 
параметры 
компонентов и 
устройств 
телекоммуникационных 
систем 

Знает теоретические 
основы работы,  
конструкцию элементов 
сети микропроцессорных 
устройств, параметры 
компонентов и устройств 
телекоммуникационных 
систем 

Умеет составлять 
алгоритмы 
функционирования МПС 
для конкретных задач 

Владеет навыками 
работы с контрольно-

измерительной 
аппаратурой 

Демонстрирует уверенные знания 

теоретические основы работы,  
конструкцию элементов сети 
микропроцессорных устройств, 
параметры компонентов и устройств 
телекоммуникационных систем, не 
испытывает затруднений при ответе на 
поставленные вопросы при защите 
лабораторных работ, курсового 
проекта и на экзамене.  

 

Умеет составлять алгоритмы 
функционирования МПС для 
конкретных задач, умеет пояснять их 

на зачете по лабораторным работам;  

 

Выполняет лабораторные работы 

самостоятельно, используя 
техническую и учебную 

документацию, демонстрирует 
уверенные навыки работы с 
контрольно-измерительной 
аппаратурой 

 

 

 



 

Шкала оценивания. 
 

Зачета 

5-балльная шкала Критерии оценки 

«зачет» 

На вопросы даны полные аргументированные ответы. Студент 
демонстрирует сформированность дисциплинарных 
компетенций на итоговом уровне, обнаруживает всестороннее, 
систематическое и глубокое знание учебного материала. 

Студент усвоил основную литературу и знаком с 
дополнительной литературой, рекомендованной программой, 
свободно оперирует приобретенными знаниями, умениями, 
применяет их при выполнении заданий. 

«незачет» 

Студент демонстрирует сформированность дисциплинарных 
компетенций на уровне ниже порогового, проявляется 
недостаточность знаний. Дисциплинарные компетенции не 
сформированы. Проявляется полное или практически полное 
отсутствие знаний по темам дисциплины, отсутствуют навыки 
решения задач. 

 

 

3. Методические материалы, определяющие процедуры оценивания по дисциплине 

3.1. В ходе реализации дисциплины используются следующие формы и методы 
текущего контроля  

Тема и/или раздел Формы/методы текущего 
контроля успеваемости 

ПК-4.2 Знает теоретические основы работы,  конструкцию, параметры компонентов и 
устройств телекоммуникационных систем 

Классификация цифровых вычислительных устройств  
Системы счисления. Форматы чисел. Машинные коды 

Комбинационные элементы. Шифраторы. Дешифраторы. 
Мультиплексоры. Демультиплексоры. Сумматоры. 
Преобразователи кодов 

Триггеры. Счетчики 

Регистры. Запоминающие устройства 

Программируемые логические интегральные схемы (ПЛИС) 
Микропроцессоры 

Форматы команд. Разработка ПО микропроцессора 

Интерфейсы микропроцессора.
 

Лекционные занятия/зачет 

Логические операции с кодами. Изучение систем счисления 

Логические основы цифровой техники 

Моделирование работы и минимизация комбинационных 
цифровых устройств 

Моделирование работы мультиплексоров и 
демультиплексоров. 

Лабораторные занятия/зачет 



Исследование работы триггеров и цифровых устройств, 
работающих на их основе  
Исследование работы Компараторов, Счетчиков 

Исследование работы аналого-цифрового и 
цифроаналогового преобразователей 

Система команд микроконтроллера. 
Программирование микроконтроллера  на языке ассемблера.

 

 

3.2. Типовые материалы текущего контроля успеваемости обучающихся 
 

 ПК-4.2 Знает теоретические основы работы,  конструкцию, параметры компонентов и 
устройств телекоммуникационных систем 

Типовое задание для лабораторных работ по дисциплине: 

Лабораторная работа №1 Логические операции с кодами. Изучение систем счисления 

Цель:  
1.1. Закрепить знания по системам счисления, усвоить принципы математических 

операций в различных системах счисления. 
1.2. Изучить принципы моделирования логических схем в программном пакете Multisim. 

 

Задание: 

1. Определить максимальное значение целого n-разрядного двоичного числа. 
2 Определить максимальное значение числа с n-разрядами целой части и m-разрядами дробной 
части. 
3 Преобразовать приведенные ниже восьмеричные и шестнадцатеричные числа в двоичную 
систему счисления: 
1) 7356,0418 - X2 

2) 4012,5678 - Х2 

3) A1F,0216 - X2 

4) E07,D3A16 - X2 

4.4 Перевести в десятичную систему счисления следующие числа: 
1) DA31016 - X10 

2) 70A0B16 - X10 

3) F7BC416 - X10 

4) D08,4C16 - X10 

5) 753148 - X10 

6) 407058 - X10 

7) 753,148 - X10 

8) 407,058 - X10 

9) 1110100111111011112 - X10 

10) 1010011100101101002 - X10 

11) 1110100111,111011112 - X10 

12) 1010011100,1011012 - X10 

4.4 Перевести следующие десятичные числа в шестнадцатеричную систему счисления: 
1) 4108710 - X16 

2) 1594810 - X16 

3) 2807,88610 - X16 

4) 3962,77310 - X16 



4.5 Пользуясь дополнительным и обратным кодами, сложить следующие пары чисел: 
1) N1= + 010,1112; N2= + 010,0112; 

2) N1= + 110,1012; N2= - 101,0112; 

3) N1= - 110,1012; N2= + 101,0112; 

4) N1= - 010,1112; N2= - 010,0112; 

 

4 Порядок выполнения работы: 
Разработка любого радиоэлектронного устройства включает физическое или математическое 
моделирование. Физическое моделирование связано с большими материальными затратами, так 
как требует изготовление макетов и их трудоемкое исследование. Иногда чисто физическое 
моделирование просто невозможно из-за сложности устройства. В этом случае прибегают к 
математическому моделированию с использованием средств и методов вычислительной техники.  
Наиболее простой и легко осваиваемой программой, содержащей блок логического 
моделирования цифровых устройств, является программа Multisim  

 

5. Создать в программном пакете Multisim схему для исследования логического элемента "И" 

 Создание новой схемы рассмотрим на примере исследования серии следующих 
логических элементов (рис. 1): 

 
Рис. 1 – Схема исследования логического элемента «И» 

 

 Для размещения компонентов на рабочей области в Multisim служат кнопки панели 
инструментов, расположенной горизонтально в верхней стороне окна. Компоненты, 
необходимые для создания схемы, сгруппированы в логические разделы. Каждому логическому 

разделу соответствует кнопка на шкале инструментов. При нажатии на одну из этих кнопок 
открывается соответствующая панель, содержащая кнопки для каждого компонента, входящего 
в семейство компонентов. 
Разместите на странице схемы компонент источника постоянного напряжения +5 В. Для этого 
необходимо: 
1. Нажать на кнопку Sources. Откроется панель, содержащая источники напряжения или тока 
(рис. 2).  
2. Щелкнуть по вкладке Power sources > DC power > OK. Курсор примет форму выбранного 
компонента. Поместить выбранный компонент на схему и щелкнуть левой клавишей мыши по 
точке схемы, в которой должен быть расположен компонент, изображение компонента появится 
на схеме.  



 
Рис. 2 – Расположение закладки с источниками питания 

 

 3. Если необходимо изменить свойства компонента (порядковый номер, имя и величину 
значения), то следует дважды щелкнуть по изображению компонента. Откроется диалоговое 
окно Digital Power. Название окна зависит от назначения компонента. Это окно содержит 
вкладки, по умолчанию открыта вкладка Value, на которой расположены текстовая строка и 
выпадающий список. 
По умолчанию значение напряжения источника равно 12 В. Чтобы изменить напряжение 
источника питания, нужно в текстовой строке вкладки вместо цифры 12 ввести 5, затем щелкнуть 
по кнопке OK (рис 3). 
В выпадающем списке указаны единицы измерения. 
 

 
 

Рис. 3 – Диалоговое окно Digital Power с вкладкой Label 

 

Установите параметры "видимости" отображаемых элементов на схеме. На вкладке Display 

имеется пять флажков, устанавливающих видимость: 
Use Schematic Option global setting – всех надписей компонента; 

Show labels – ярлыка компонента; 
Show values – величины значения компонента; 
Show reference ID – порядкового номера компонента; 
Show Attributes – таблицы свойств. 
Если установлен флажок Use Schematic Option global setting, то остальные флажки имеют серый 
цвет и не доступны. 
На вкладке Fault (погрешность) устанавливают границы погрешности. 
Чтобы разместить на схеме изображения четырех компонентов «НЕ» и одного компонента «И», 
необходимо:  
1. Нажать кнопку Misc. Digital. Откроется панель с соответствующими компонентами (рис. 4). 
 



 
 

Рис. 4 – Расположение кнопки Misc. Digital 

 

2. Нажать на кнопку с изображением логического элемента. Откроется диалоговое окно, в 
котором имеется окно просмотра Component, содержащее список цифровых компонентов. Во 
втором окне Symbol появляется изображение выбранного компонента в формате ANSI (США) 
или DIN (Европа). 
3. В списке компонентов выбрать компонент 2И (AND2) и поместить его на схему, щелкнув по 
кнопке OK. Ускорить поиск компонента можно, если ввести несколько первых символов имени 
компонента в строку Component (рис. 5) 
 

 
 

Рис. 5 – Список компонентов в закладке 

4. В списке компонентов выбрать компонент НЕ (NOT) и расположить четыре образца этого 
компонента на рабочей поверхности Multisim. 

5. Разместите на схеме два переключателя на два положения. Для этого необходимо: 
Нажать кнопку Electromechanical. Откроется панель с соответствующими компонентами. 
Выбрать кнопку SUPPLEMENTARY_CONTACTS. Откроется диалоговое окно Component 

Browser (рис. 6). 
В окне просмотра (рис. 6) Component Name List выбрать компонент SPDT_SB и поместить два 
образца этого компонента на схему.  
 



 
 

Рис. 6 – Диалоговое окно Component Browser 

 

Чтобы повернуть эти образцы компонента на нужный угол по горизонтали или по вертикали, или 
на 90° вправо или влево, необходимо: щелкнуть правой клавишей мыши по компоненту. 
Откроется контекстное меню, в нем выбрать нужную строчку и щелкнуть левой клавишей мыши 
по этой строке. 
Разместить на схеме три светодиода. Для этого необходимо: 
Нажать кнопку Indicator. Откроется панель инструментов (рис. 7). 
Щелкнуть по кнопке с изображением лампоки и поместить три образца этого компонента на 
схему. 
При необходимости повернуть эти образцы компонента на нужный угол (как описано выше). 
 

 
 

Рис. 7 – Панель выбора компонентов Probe 

 

Схема, содержащая цифровые компоненты, должна включать источник напряжения VCC и 
символ «цифровая земля» Digital ground, которые Multisim использует для подачи питания на 
цифровые компоненты. 
Разместите на схеме изображение символ «земля». Для этого необходимо: 



Нажать на кнопку Sources. Откроется панель, содержащая источники напряжения или тока и 
символы «земля». 
Поместить на схему символы «земля» и «цифровая земля», нажав кнопки Ground и Didgital_Gnd 

соответственно (рис. 8). 
 

 
 

Рис. 8 – Расположение элементов Ground 

 

Разместить на схеме вольтметр. Для этого необходимо: 
Нажать кнопку Indicator. Откроется панель инструментов Indicator. 

Поместить на схему вольтметр, нажав на кнопку Voltmeter (рис. 9). 
 

 
 

Рис. 9 – Расположение вольтметров  
 

В результате страница схемы будет выглядеть так, как показано на рис. 10. 
 



 
 

Рис. 10 – Страница схемы с размещенными на ней компонентами 

 

 

Соедините схему проводниками, в результате выполнения соединений, схема будет выглядеть 
так, как показано на рисунке 11. 
 

 

 
 

Рис. 11 – Схема исследования логических элементов 

 

В отчете необходимо привести собранную схему, с указанием всех элементов. Под схемой 
необходимо указать расположение всех элементов в программе Multisim и их основные 
параметры.  
Далее необходимо запустить процесс моделирования, чтобы исследовать поведение устройства. 
Для того чтобы запустить процесс моделирования, нужно щелкнуть по кнопке Simulate, и из 
всплывающего меню выбрать команду Run. Слева от команды Run появится галочка, 
означающая, что процесс моделирования начался. 



Процесс моделирования можно запустить, или приостановить с помощью команд 
Simulation>Run и Simulation>Pause соответственно. 
Процесс моделирования можно запускать и останавливать с помощью переключателя, который 
можно сделать видимым или невидимым с помощью команды View>Show Simulation Switch. 

 

5.2 Создать в программном пакете Multisim схему устройства с параллельными входами, 
осуществляющем операцию "И" над трехразрядным двоичным числом: 
5.2.1 При выполнении задания необходимо использовать логические элементы "И", блок 
питания, землю, индикаторы.  
5.2.2 На вход устройства подавать трехразрядные числа в соответствии с вариантом (по номеру 
в журнале): 
Вар. 0 1 2 3 4 5 6 7 8 9 

Число 1 001 010 011 100 101 110 111 101 110 111 

Число 2 101 110 111 101 110 111 001 010 011 100 

 

 

7. Контрольные вопросы: 
7.1 Дайте определение системы счисления? 

7.2 На какие два типа можно разделить все системы счисления? 

7.3 Какие системы счисления называются непозиционными? Почему? Приведите пример такой 
системы счисления и записи чисел в ней? 

7.4 Какие системы счисления применяются в вычислительной технике: позиционные или 
непозиционные? Почему? 

7.5 Какие системы счисления называются позиционными? 

7.6 Как изображается число в позиционной системе счисления? 

7.7 Что называют основанием системы счисления? 

7.8 Что называют разрядом в изображении числа? 

7.9 Как можно представить целое положительное число в позиционной системе счисления? 

7.10 Приведите пример позиционной системы счисления. 
7.11 Опишите правила записи чисел в десятичной системе счисления:  
а) какие символы образуют алфавит десятичной системы счисления?  
б) что является основанием десятичной системы счисления?  
в) как изменяется вес символа в записи числа в зависимости от занимаемой позиции? 

7.12 Какие числа можно использовать в качестве основания системы счисления? 

7.13 Какие системы счисления применяются в компьютере для представления информации? 

7.14 Охарактеризуйте двоичную систему счисления: алфавит, основание системы счисления, 
запись числа. 
7.15 Дайте характеристику шестнадцатеричной системе счисления: алфавит, основание, запись 
чисел. Приведите примеры записи чисел. 

 

  



 

3.3. Типовые материалы для проведения промежуточной аттестации обучающихся 

 

Типовые вопросы и задания к зачету:  

1. Что называется системой счисления? 

2. На какие два типа можно разделить все системы счисления? 

3. Какие системы счисления называются непозиционными? Почему? Приведите пример 
такой системы счисления и записи чисел в ней? 

4. Какие системы счисления применяются в вычислительной технике: позиционные или 
непозиционные? Почему? 

5. Какие системы счисления называются позиционными? 

6. Как изображается число в позиционной системе счисления? 

7. Что называется основанием системы счисления? 

8. Что называется разрядом в изображении числа? 

9. Как можно представить целое положительное число в позиционной системе 
счисления? 

10. Приведите пример позиционной системы счисления. 
11. Какие числа можно использовать в качестве основания системы счисления? 

12. Какие системы счисления применяются в компьютере для представления 
информации? 

13. Охарактеризуйте двоичную систему счисления: алфавит, основание системы 
счисления, запись числа. 

14. Почему двоичная система счисления используется в информатике?  
15. Дайте характеристику шестнадцатеричной системе счисления: алфавит, основание, 

запись чисел. Приведите примеры записи чисел. 
16. По каким правилам выполняется сложение двух положительных целых чисел? 

17. Каковы правила выполнения арифметических операций в двоичной системе 
счисления? 

18. Для чего используется перевод чисел из одной системы счисления в другую? 

19. Функционирование RS-триггера на логических элементах 2-И-НЕ.  
20. Функционирование RS -триггера на логических элементах 2-ИЛИ-НЕ.  
21. Схемы контроля четности.  
22. Схемы сравнения.  
23.  Цифровые компараторы.  
24. Схемы с открытым коллектором.  
25. Нагрузочная способность микросхем серий ТТЛ, ТТЛШ, КМОП.  
26. Шинные формирователи. 
27. Кольцевые сдвиговые регистры.  
28. Мажоритарные элементы. 
29. Шифраторы и Дешифраторы кодов.  
30. Функционирование JK-триггера.  
31. Функционирование JK-триггера в режиме D-триггера.  
32. Недостатки счетчиков с последовательным переносом.  
33. Преимущества и недостатки счетчиков с параллельным переносом.  
34. Функционирование и состав параллельных регистров.  
35. Функционирование и состав последовательных регистров. 
36. Функционирование И состав двоичных сумматоров.  
37. Счетчики с произвольным коэффициентом пересчета.  
38. Функционирование D-триггера в счетном режиме.  
39. Схема счетчика с параллельным переносом на JK-триггерах. 
40. Цифровые мультиплексоры.  
41. Правило перехода от таблицы истинности к СДНФ.  



42. Методы и типы АЦП.  
43. Статические параметры АЦП. 
44. Понятие дискретности, квантование, разрешающая способность. 
45. Характеристика преобразования, дифференциальная нелинейность АЦП, отклонение 

коэффициента преобразования.  
46. Динамические параметры АЦП.  
47. Время преобразования, время задержки запуска, время цикла преобразования, 

максимальная частота преобразования.  
48. Факторы, влияющие на погрешность АЦП. 
49. Аппаратные реализации АЦП.  
50. Построение схем АЦП с помощью микросхем ЦАП.  

51. Понятие архитектуры микропроцессора.  
52. Принципы организации процесса обработки информации.  
53. Типовая структура обрабатывающей части микропроцессора.  
54. переноса, сдвига и формирования признаков результата арифметических операций.  
55. Организация управления процессом обработки информации. 
56. Микропрограммный и аппаратный принципы управления выполнением операций. 
57.  Микрокомандный и командный уровни управления. 
58.  Программный счётчик и регистр команд.  
59. Статическое и динамическое ОЗУ..  
60. Микрокомандный и командный уровни управления 

61. Классификация методов ввода-вывода. Программный ввод-вывод без квитирования. 
Программный ввод-вывод с квитированием. Ввод-вывод по прерыванию. Ввод-вывод по 
прямому доступу к памяти. 

62.  Интерфейс и его функции.  Программируемый параллельный и последовательный  
интерфейс. Программируемый связный интерфейс.  

63. Организация многоуровневых, приоритетных, опросных и векторных прерываний. 
 

 

Банк контрольных вопросов, заданий и иных материалов, используемых в процессе 
процедур текущего контроля и промежуточной аттестации находится в учебно-методическом 
комплексе дисциплины и/или представлен в электронной информационно-образовательной 
среде по URI: http://www.aup.uisi.ru.  

 

3.4. Методические материалы проведения текущего контроля и промежуточной 
аттестации обучающихся 

Перечень методических материалов для подготовки к текущему контролю и 
промежуточной аттестации: 

1.Методические указания по выполнению лабораторных работ по дисциплине 
«Микропроцессорная техника в системах связи». –URL: http://aup.uisi.ru 

 


